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I. A Quick Tour of F9

A Quick Tour of F9

This is a short tutorial designed to familiarize you with the basic concepts of creating financial reports with
F9. Every F9 financial report starts as a spreadsheet and uses the features of Microsoft Excel 2007 and F9

Version 5.

For this reason you will also find Excel's online Help to be an invaluable aid when you create your financial

reports. To find complete information about any F9 feature,r e f e r

t -ine HeYp’'fos mooerdetails.

Where there are differences between Excel 2007 and 2010, separate instructions and screenshots will be

listed.

1. Getting Started

1. Open Excel and ensure F9 is attached.

There should be an F9 tab to select within the Excel Ribbon:

Excel 2010:
@l = k= Microsoft Excel = = £
Home Insert Fage Layout Formulas Data Review View Fg - The Financial Reporter & e
§+l_| @’_i i j—': 55 Chart =,7 [EHraReport Controls - EE F9 Lists 55 F9 Setup ~ 2 F9 Help
I : =/ .
' @B Budget Writeback | — @Zero Suppress = % FE Maintenance ﬁjFQAdd—in Options | 7= About F9
Report Inguire Table Fivot Table - Drrill _
Wizard and Paste Report Report L Analyze Down g’a Fublish F9 = E Migrate Fovd.x [EE] License Manager -
F& Reporting F2 Analysis . F2 Tools _ Preferences Help
I
Excel 2007:
. r : B i
( 3 \ = Microsoft Excel - = X
—/ Home Insert Page Layout Formulas Data Review View Fa - The Financial Reporter '@)
3 [ o= > Chart =7 3 F3 Report Controls - | EE FA Lists 33 F9 Setup - 2 F9 Hel
8[| als Bt AN
- @B Budget Writeback | — @Zero Suppress * % FE Maintenance [[“’;]FQAdd-in Options | P2 About F9
Report  Inguire Table PivotTable - Crill ) ) _
Wizard and Paste | Report  Report () Analyze Down Qa Publish F2 - ;% Migrate FOv4 x [EF] License Manager ~
F9 Reporting (P F2 Analysis (P F9 Tools (F] Preferences Help

If the F9 Ribbon is not present, please refer to Installation and Setup instructions installed in the F9 folder

called: F9 Readme for (your product).PDF.
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2. Ensure that you have a blank workbook open.

Excel 2010:
.
To open a blank workbook, choose the File Tab , New, Blank Workbook, and Create.
[z“ H -
Home Insert Page Layout Formulas
H Save
Available Templates
Save As
E3 Open {3 Home
' Close . l|
Ve T ™
Info l/’.‘
Recent Blank Recent

workbook templates

Cffice.com Templates
Print o—" EE'
Save & Send . - \

Agendas Budgets

Excel 2007: _
Ca
To open a blank workbook, choose the Office Button “~* , New, Blank and recent, and Create.
= R R

J Templates

Paste I Elank and recent l
Installed Templates Blank and recent

; My templates...

Mew from existing...

Microsoft Office Online

Featured lank Workboo

Agendas
Budgets

Calendars
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3. Ensure Calculation in Excel is set to Manual.
This allows users the most control on when F9 results will be refreshed.

Excel 2010:

Fil
Select the File Tab , Options, Formulas and click Manual as shown:

Excel Options

General een P . .

‘—‘_‘ﬂ Change options related to formula calculation,

[ Formulas l

Proofing Calculation options

Save Workbook Calculation

) Automatic
Language () Automatic except for data tables
Advanced @ Manual
Recalculate workbook before saving
Customize Ribban

Excel 2007: )
(a
Select the Office Button “* , Excel Options, Formulas and click Manual as shown:

Excel Options

Popular "ﬁ * d .
° '—‘_“fj Change options related to formula calculation,
[' Formulas -l

Proafing Calculation options
Save Workbook Calculation G

{} Automatic
Advanced {} Automatic except for data tables
Customize * Manual

|:| Recalculate workbook before saving

Add-Ins

With Manual Calculation, you can calculate an entire workbook (or all open workbooks) by pressing the F9
key. Shift+F9 is used to calculate the active visible worksheet and F2+Enter calculates just the active cell.
To save you time, all F9 reports should be created with Excel set to Manual Calculation so that the entire
workbook does not recalculate every time you edit a cell.
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4. Next, ensure F9 is setup to access the Demo company data and continue with this quick tour. Select
from the F9 Ribbon F9 Setup. If you do not see the Macola Demo company listed in the Company

dropdown, select Browse and locate where the Macola.cfg file which describes the location of your
accounting data is.

. F9 for, Macola Progression 7.x MS SQL Setup &|

File Path; |Cr\MacSAL

Browse

Comparss: |DD2 Macola Dema

[Data Source

j Company Prafile

[ atabaze
Marne:

[~

Uszer |D: |

[ Usze Trusted Caonnection

R econnect

Zero Label; |0
Scaling |[Mone  »
Founding: |Mone =

| Status | Connected to Server.

Year [1934 -
Period: |OFF =

Fevision: |01

Ancaunt:
Profit Center:
Department;

-

Murmeric  Alphabetic Alphanumeric

[v Return Zero for Accounts Mok Found

~
r~
~

- (s
(" i»
" (s

Financial Entities Setup > >

Help Cancel | ok |

5. For more information on the data F9 accesses for your accounting system, refer to the Information

sect

i on

A

t hi

n

F 9F9 Welp @ tie FbRibbasiel 7 F2HER| 1 g
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2. Quick Trial Balance

1.

F9 can quickly output your Chart of Accounts and period values in a variety of ways. To begin, select
from the F9 Ribbon, Table Report. A F9 task pane will display to the right of the active worksheet.

Hover the mouse on t he tagtekdispmatotbe ledt orisaettthe drapdowne r

control at the top of the task pane and Size to control the display and docking.

F9 Table

Source l Options l

Companies
002

Budgets; Years;

|01 j |1994 j

Within the tab: F9 Table, set the F9 dropdowns to output the entire Chart of Accounts by typing an *
in each account part; select the demo Company, 01, 1994 and Month 1:

F9 Table v X

Source ] Options ]

Companies:

?
|o02 |

Budgets: Years:

|o1 x| [1oss =]

Period: h

[Manth 1 |
7 Usewhole Account

hain:

5 [

Profit Center:

5 [

Cepartrnent:

5 [

Next select tab: Options.

e F9 Chart: select Include Account Code, Description and Account Origin
e Output: select F9 Classic Chart, Static Values, New Sheet
e Formatting: select Add Total Row, Default Table Style

Click on the Find button at the bottom of the F9 Table task pane to see the results output in a new
worksheet. The columns will be sized to display your information and should like similar to the
following:
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LDDO*-.IU\U\JEL\)NHU

BN NN e e e e e e e
%@~ o o) R - - - BW NS

A B
]
Companie 002
Years 1994
Budgets 01

Accounts: (*)(*)(*)

Account

00000-10000-00000
00000-20000-00000
00000-30000-00000
01005-00000-00000
01005-10000-00000
01005-20000-00000
01005-30000-00000
01010-00000-00000
01010-10000-00000
01010-20000-00000
01010-30000-00000
01011-00000-00000
01012-00000-00000
01013-00000-00000
01014-00000-00000
01015-00000-00000
01016-00000-00000
01017-00000-00000
01018-00000-00000
01020-00000-00000

Description

West Coast Headguarters
North Headgquarters
South Headguarters
Petty Cash

Petty Cash West

Petty Cash North

Petty Cash South

Bank Acct USA

Bank Acct USA West
Bank Acct USA North
Bank Acct USA South
Bank Acct Canadian Daollars
Bank Acct Deutschmarks
Bank Acct French Francs
Bank Acct Hong Kong
Bank Acct Jamaican

Bank Acct Italian Lira
Bank Acct Mexican Pesos
Bank Acct UK Pounds
Bank Acct Payroll USA

Qarigin

P/L

P/L

P/L

Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet
Balance Sheet

Month 1

180,812.00

00000000000

-689,344.74

5. As atrial balance, we normally should ensure the total for the period totals zero. We set F9 Table to
create the subtotal formula within the Options tab and we can scroll to the end of the report or a faster
technique is to use the keyboard End key:

The

as:

a. Click on any cell in column E with a value.
b. Click the End keyboard key and then the down arrow key.
c. Excel should bring you to the end of the report in column E.

I ast
I -1009?31.9!

cel |

should contain a®#SUMBERSERD) ongigsyalllie ...)

This is not zero using the Macola demo company data which is incomplete but should be for your
real company data.

6. To improve the format of this cell, select the Excel Home tab and within the group Number the

comma option:
General =
$ - % o0 5%
Mumber fa

The value in the trial balance total should now display as: @! To return to the top of
the report, click at the same time: Ctrl + Home from the keyboard.

f or mu
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7. Notice the current report contains accounts with zero amounts. One way to not display these rows is
to use the F9 Zero Suppress command. First, select the range of information to suppress — one way
is to highlight the entire column E. Click the F9 Ribbon tab and within group F9 Tools, select Zero
Suppress and then Zero Suppress Rows from the dropdown.

Qs Zero Suppress ™ :&'j

Qﬁ Zero Suppress All

g Zero Suppress Rows
J]j' Zero Suppress Columns
Undo Zero Suppress

The F9 report should now display just rows with amounts. Notice the rows with zeros have been
hidden in Excel. To redisplay the rows at any time, simply highlight the area and select Undo
Zero Suppress.

8. Rename the worksheet containing the F9 trial balance report to: Trial Balance 1.

{ On
9. Save the workbook as F9 Tour.xIsx by selecting the Excel button *~* , Save As, Excel Workbook.

Notice the default extension in Excel 2007 is now .xIsx; this means the file is stored in XML format
which will be approximately 60 per cent smaller in size from the same report saved as an .xls file,
whichi s Excel’'s previous binary output.

There are many other benefits to saving Excel files to the new XML format such as improved stability
of files with less chance of corruption issues; in addition, Excel’ XML can be extended by other
applications programmatically and is the industry standard for web-based communications.

3. A More Dynamic Trial Balance

In the first example, F9 Table output the most basic report with just values in the rows and one subtotal at
the end. Next, we will generate the same report with dynamic report controls and F9 formulas to return
descriptions and values across all account rows.

1. First, we will ensure F9 is setup to create report dropdown controls. From the F9 tab, group Options,

select F9 Add-in Options [ #9840 Optiens| Fnq e Create F9 Report Controls is selected and hit
OK. We will see how this works with a new report created by F9 Table.

RE9 Addin Options

[v Always Calculate Fundions

|¥ CreateF3 ReportControls

[~ SupportMultiple Topics onSharePoint

Function Timeout

Color Scheme
’7(5“ Auto " Blue " Silver (" Black ‘

oK Cancel |
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2. Back to the F9 Table task pane, we will make just one change within the Options tab:

a.
3. Click on the
worksheet.

Output: select F9 Classic Chart, GL Formulas, New Sheet
Find button at the bottom of the F9 Table task pane to see the results output in a new

A

Years
Budgets

[N R ER. TR TR

R I N N O T e T
SRR =R =R R RS TSR Y

Companies 002

Accounts:

1994
01

(1))

Periods Month 1

Account Description Origin Amount Month 1
01005-00000-00000 Petty Cash Balance Sheet 50.00
01010-00000-00000 Bank Acct USA Balance Sheet 180,812.00
01020-00000-00000 Bank Acct Payroll USA Balance Sheet -689,344.74
01030-00000-00000 Marketable Securities Balance Sheet 126,000.00
01100-00000-00000 Inventory-Raw Materials Balance Sheet 504,623.72.
01136-00000-00000 Inventory-WIP Balance Sheet 1,500,000.00
01140-00000-00000 Inventory-Finished Goods Balance Sheet 1,025,000.00
01200-00000-00000 Prepaid Expenses Balance Sheet 14,600.00
01300-00000-00000 Machinery & Equipment Balance Sheet 1,204,500.00
01380-00000-00000 Buildings Balance Sheet 580,600.00
01385-00000-00000 Accum Depr-Buildings Balance Sheet -264,992.00
01400-00000-00000 Land Balance Sheet 41,500.00

02000-00000-00000  Accts Davahle Trade 1 heat 0 nn

4. There are two differences in this report:

o}
b.
C.

o The

First, F9 report dropdown controls are created for easy selection.

Change the year to 2007 and click Shift-F9 to recalculate the trial balance; values for all
account rows update automatically. How this is done is with F9 formulas that are based
on a number of different filters and parameters.

Change the period in column E to Month 6 and recalculate again. F9 recognizes
accounting like phrases to retrieve period balances.

second and most significant change is that F9 formulas have been written to control the

results returned for all rows with accounts. This makes the report dynamic; change a
reporting filter such as Type and values change with recalculation; post transactions to the
GL and recalculate an F9 report to see new values automatically. No recreation of your report
required.

a.

Edit the account specifier in cell B11; change it from: 01005-00000-000 to: 01*-*-*. Click
Shift-F9 to see the new period total for the account grouping. This is one example of how
to combine multiple criteria within F9 formulas.

Delete the rows of accounts we just combined. Highlight the 11 entire rows below the
new account and right-click to Delete. Your trial balance total should once again be zero
as expected.

Save this worksheet tab as: Trial Balance 2 and save your entire workbook also.

Now that we have created a more dynamic Trial Balance report that can recalculate with different results
when a report filter such as the Period changes, we will want to start learning the how F9 formulas work
to create flexible reports of any nature.
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I[I. The Fundamental F9 Formula

The GL Function is the fundamental F9 formula as it links any cell in your spreadsheet to any balance in
your general ledger. This is accomplished with a set of parameters that tell F9 what balance you would
like returned. The syntax of the GL formula is:

=GL(Account, Period, Company, Year, Type, Currency)

Where:
Account is the GL account(s) specifier
Period is the fiscal period(s)
Company is one or more company specifiers
Year is the specific fiscal year
Type is the actual or budget type

Currency s the currency type (if supported in your accounting system)

Write this formula down; in fact write it down twice, as it is the core of all F9 Reports.
The GL formula does not require all 6 parameters, so if your accounting system does not support
currencies, you do not need to enter this specifier.

In many instances you will want your balances to be returned as negative values. To do this, simply use
the= N GL ( fuéction in place of the GL function. The parameters of the NGL function are identical to
the GL function.

1. The GL Formula

=

Open the F9 Tour workbook, and select the Trial Balance 1 worksheet tab.
2. Unhide the zero suppressed rows to work with all accounts. Select the entire worksheet by clicking on
the upper left corner:
] Fo Tour.xls
A

o

Next, from the F9 tab, select Zero Suppress and Undo Zero Suppress.

3. Cell E9 should contain your first period amount. Click on cell E9 and you will see that although there
is a value in this cell, there is no formula. The true strength of F9 is rooted in F9 formulas and the
ability of all spreadsheets to use absolute and relative cell references so that they can turn on a single
cell.

4. In cell E9 type the GL formula, substituting the appropriate cell reference for each parameter of the
GL formula. In the example below, as in your sheet, the GL Formula will be:

=GL(B9,E8,B2,B3,B4)
Where:
B10 is the Account number
E9 is the Period
B2 is the Company
B3 is the Year
B4 is the Type
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E:f B G D E F

1

2 |Companig002

3 Years 1934

4 |Budgets |01

5

6 |Accounts: (*)(*)(*)

7

8 Account Description Origin
9 [00000-10000-00000 Jwest Coast Headquarters P/L |=6L89,E2,82,83,84)
10 00000-20000-00000 North Headgquarters P/L o
11 00000-30000-00000 South Headgquarters P/L 0.00
12 01005-00000-00000 Petty Cash Balance Sheet 50.00

ENSURE THAT YOUR CELL REFERENCES ARE CORRECT and press F2+Enter to calculate the cell. If
the formula is correct, the cell will return the same value, but it will now be based on an F9 formula.

As you will notice, none of the other values below cell E9 have changed. This is because they are not
formula based. Don't worry, though; you do not have to type the GL formula again if you use the correct
Absolute and Relative cell references and Auto-Fill.

e Absolute and Relative Cell Referencing

By default, a formula you create in Excel uses Relative cell references. This means that if you copy a
formula, Excel will automatically adjust the cell references in the copied formula to refer to different cells,
relative to the position of the original formula. So, if we copy this formula from cell E9 to cell E10, all row
references will change by one row. This formula would then be: =GL(B10,E9,B3,B4,B5).

In the new formula, the Account specifier (B10) is correct, but the Period specifier is now cell (E9), which
is obviously not correct. In fact, the Company (B3), and Year (B4) are also incorrect now. To copy this
formula correctly, we will have to ensure that Excel does not adjust the cell references when we copy the
formula. This is called an Absolute reference and is accomplished by placing a dollar sign ($) before the
parts of the reference that should not change.

1. Click on cell E9, and in the formula bar (located at the top of the spreadsheet, above the column
names) move your cursor to the beginning of the Account reference (B9).

@| =GL(B3,E8,B2,B3,84)

2. Press F4. Each time you press F4, Excel toggles through the combinations: absolute column and
absolute row ($B$9), relative column and absolute row (B$9), absolute column and relative row
($B9), and relative column and relative row (B9). We will want the Account reference to change as we
copy down rows (relative, no $), but not across columns (absolute, $). Press F4 until the Account
reference is $B9. You can also add the $ symbol with the keyboard.

3.  We will not want the Period reference to change as we copy it down rows, but we will across columns
(relative column and absolute row). Make the Period reference E$8.

4. The Company, Year, Type and Currency cell references should not change when we copy the
formula down or across the report, so make both the column and row references absolute as: $B$2,
$B$3, and $B$4.

5. Press Enter to complete formula edit.

The formula should now be: =GL ($B9,E$8,$B$2,$B$3,$B$4) and is ready to be copied down all of the
account numbers.

10
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e Auto-Fill

1. Before we copy the new F9 formula to all the rows below, go to the last row and insert a blank row
(On the ribbon Home->Insert->Insert Sheet Rows) between the Total and the last account. We will
see why this is required once the Excel Auto-Fill completes. Select Ctrl-Home to return to the top of
the report.

2. Click on the cell with our first GL formula, (E9). You will see a fill handle which is located at the
bottom right of the cell when it is selected. Move your mouse over the fill handle, and your pointer will
become a crosshair.

—1

F1l Feardia

3. Double click the fill handle. The formula will now copy down all rows that have an adjacent value in
Column D. If there is no value in Column D, or if your version of Excel does not support this feature,
simply drag the formula down by clicking and holding the left mouse button over the fill handle and
dragging the formula until the last row with an account number is selected.

4. Click on any cell in your spreadsheet. You will notice that all of the cells have the same value as cell
E9. This is because the sheet is set for manual calculation. Press F9 to calculate the workbook, and
the values from your GL will populate the report.

2. Description Formulas

We will now want to make the descriptions in this report formula-based so that when you edit an account
number it will return the appropriate description.

In F9 there are two formulas for returning account descriptions, these are the =DESC Function and
=SDESC Function. DESC returns the account description for the full account code. If the DESC function
is used on a range or list of accounts, it returns the description for the first account found in the range or
list. SDESC produces the descriptions associated with the individual segments of the account code. In
short, the DESC is used to return the Natural Account description and SDESC is used to return the Sub-
Account description.

e The DESC Function

The syntax of this formula is the similar to the GL function with less specifiers:

=DESC(Account, Company)

Where:
Account is the GL account(s) specifier
Company s the specific company

11
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e The SDESC Function
The syntax of this formula is:

=SDESC(Segment, Segment Number, Company)

Where:
Segment is the GL segment specifier
Segment No is the segment position
Company is the specific company

Segment Number always contains the number of the segment you wish a description for. The first
segmentis "1."

Make the descriptions in this report formula based

1. Make cell C9 active and ensure its format in Excel is General. Right-c | i ck and sel ect For ma
Click on category General and hit Ok.
2. In C9, enter the =DESC formula, referencing the appropriate cells for each parameter
[=DESC(Account, Company)]. Press Enter and recalculate this cell (F2 + Enter). If the description is
not returned ensure that your formula is correct i.e. =DESC(B9, B2).
3. Give the parameters in this formula the correct absolute and relative cell referencing. The DESC
function should now be defined as: =DESC($B9, $B$2).
4. Copy the formula down using Auto-Fill so that it covers all accounts. Ensure that you entered the
correct absolute and relative cell referencing and recalculate the current sheet (Shift +F9).
5. Save the workbook file.

The F9 report now recalculates dynamically and contains formulas to return period balances and account
descriptions. If you look at tab: Trial Balance 2, you can compare the formulas F9 created automatically
from F9 Table with Output as Formulas — they should look identical.

12
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lll. Report Creation with GL Paste

1. Report Creation with GL Paste

F9 can generate a properly formatted GL function easily for you via the Inquire and GL Paste command.
GL Paste is useful if you need to create reports with specific segment filters or groupings such as by
Department as well as a good first step to creating your own formatted report with the most flexibility.

GL Paste creates the first GL formula in a new worksheet along with all required parameters properly
referenced with the correct absolute and relative cell referencing.

e

For settings, set to:

Company:
Budget:
Year:

Main:

Profit Center:
Department:

Click on the Sheet 1 Tab and rename this sheet to: GL Paste.
If the F9O Table task pane is displayed, close this first.
From the F9 ribbon,

choose Inquire and GL Paste. This will open the F9 Inquire task pane.

The demo company
01

1994

type 02*

type *

type *

5. Next, select Get Balance to review the total for accounts *-2*-*:

~F9 Account Ingquire

v X

Companies:

ooz

Budgers: Years:

<]

o1 x| Jazee

|

Periods

|Januar\.I

liain:

Ll

o2+
Profit Center:

Kl

Departrment:

Ll

Ll

Balance

Create GLFunction by

-S099580 65 GetBalance |
Period - L Paste |

[~ Reverse3ign [T MNewsSheet

13
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6. Next, we will paste F9 formulas to the active worksheet. Set the active cell to A1l as GL Paste will
start at the current active cell.

7. From the F9 Inquire tab, click the GL Paste button. You will see the beginnings of a new report with
F9 report dropdown controls, a GL formula properly parameterized and also a DESC formula written
to return account descriptions.

A B C D E F
-
1
2 |Profit Center: *
3 |Department: *
a
3 |Companies: 002
6 Years: 1994
7 |Budgets: 01
3 IJanuaE |v
L]
9
10 |02* Accts Payable Trade -5,099,380.88
11
12

8. Place your cell pointer on the period January. Notice it is also a F9 dropdown control and contains
many of the typical period specifiers F9 recognizes. Drag this control across to 2 more columns —the
month automatically changes for you and the dropdown control is also retained.

January February Il‘ﬂarc:h_ _l -

9. Select the cell with the account description and notice a =DESC( ) was written.

10. Select the cell with the GL amount. Change the name of the F9 formula to =NGL to have F9 return
the amount as a positive amount. Notice this GL formula contains one additional enhancement, the
F9 BSPEC( ) function which stands for Build Specifier.

[m=]
L

fil =NJGL(BSPEC($A10,5B$2,3B33),ES8, $855,5B856,5857)

11. BSPEC is used to separate the full account into separate segments to be filtered in your F9 reports.
For example, you may need to return balances for a list of departments as opposed to just one or all.
BSPEC makes combining segment groupings and filters easy. An example will illustrate this further:

a) Goto cell B3 and select Department 00000. Hit F9 to recalculate and note a new
amount returned.

b) Go to cell B2 and instead of selecting from the dropdown either type for its value:
@0000,10000, or do the right click and from the Right click menu select F9 Control List.
In the F9 Control List window select both values 00000 and 10000. Hit F9 to recalculate
again.

c) Setthe active cell to the period amount returned and select Drilldown from either F9
Ribbon or the Right click menu. Select different Drill By criteria and hit the Drill button to
view the different results. Click on any cell in Excel to return to the report.

12. Next, we will expand the report created by GL Paste by adding more rows.

14
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2. Lists

The primary role of the Lists feature is to save time manually entering data that already exists in your GL.
The List feature typically allows you to enumerate:

Segments (used most often)
Companies

Budgets

Lists

Periods

Years

1. From the F9 Ribbon, click on Lists: |55 F@ Lists
2. Select Segments under Available Lists.
¢ Inthe List Segment drop-down, select Main
e Inthe Where drop-down, select Main
¢ Inthe Is field, type 02*
3. Ensure Generate Descriptions is unchecked
4. Click Send To Clipboard, press OK to the List was Sent To Clipboard message, and Exit the Lists
window.

9 for Macola Progression 7.x MS 50L Lists E

Aevailable Lists

* Segments " Lists " BWE Headers
" Companies " Periods (" Accounts

" Revizions [ “ears

Lizt Segment:

|Main j

Where: l=:

[Main > oz [~

[ Transpose List ? [ Generate Descriptions?
Send to Clipboard Help | Exit

Next, we will want to paste this into the sheet and finish the report.

1. Select the cell that contains your first account number (Cell A10) and select Paste (Edit | Paste). This
will paste in all Accounts within the range.

2. Click on the GL formula in E10 and drag it to the other columns F10 and G10.

3. Next click on the cell with the description, D10 and highlight cells: D10 to G10.

4. Using your mouse, drag the selection down rows with accounts.

5. Hit Shift F9 to recalculate the new results.

6. Auto-Fit the description column if necessary to expand its width for display and save the report.
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o] A B c D E F G

1

2 |Profit Center: 00000,10000

3 Department: 00000

4

5 |Companies: 002

6 Years: 1994

7 Budgets: 01

8 January February March

9

10 |'02000 Accts Payable Trade -330.00 -330.00 -330.00
11 |'02001 Accts Payable Trade Canada 0.00 0.00 0.00
12 |'02002 Accts Payable Trade Germar 0.00 0.00 0.00
13 |'02003 Accts Payable Trade France 0.00 0.00 0.00
14 |'02004 Accts Payable Trade Hong Ki 0.00 0.00 0.00
15 |'02005 Accts Payable Trade Jamaicz 0.00 0.00 0.00
16 |'02006 Accts Payable Trade Italy 0.00 0.00 0.00
17 |'02007 Accts Payable Trade Mexico D.DDI D.DD! 0.00
18 |'02008 Accts Payable Trade UK 0.00 0.00 0.00
19 |'02011 Accts Payable Ex Canadian 0.00 0.00 0.00
20 |'02012 Accts Payable Ex Deutschmz 0.00 0.00 0.00
21 |'02013 Accts Payable Ex French Fral 0.00 0.00 0.00
22 |'02014 Accts Payable Ex Hong Kong 0.00 0.00 0.00
23 '02015 Accts Payable Ex Jamaican 0.00 0.00 0.00
24 |'02016 Accts Payable Ex Italian Lira 0.00 0.00 0.00
25 |'02017 Accts Payable Ex Mexican P¢ 0.00 0.00 0.00
26 |'02018 Accts Payable Ex UK Pounds 0.00 0.00 0.00
27 |'02023 Receiving Accrual Account 4,278.01 4,278.01 4,278.01
28 |'02024 Recev Inspection Accrual 0.00 0.00 0.00
29 |'02030 Capital Lease Current 46,400.00 46,400.00 46,400.00
30 |'02040 Current Portion LTD 0.00 0.00 0.00
31 |'02050 Interest Payable 20,000.00 20,000.00 20,000.00
32 '02060 Expenses Payable 0.00 0.00 0.00
33 '02070 Sales Tax Accrued 0.00 0.00 0.00
34 '02071 Sales Tax Accrued Canada 0.00 0.00 0.00
a5 |'n2n72 Sales Tay Arrmied Germanw 00N 0 .0n 0 nn

You can use the features of Excel and F9 to make this report exactly how you wish. Add sum formulas,
change single account specifiers to ranges, add a variance column to compare the current year versus
the past year, make graphs and charts. These are all benefits of creating your financial reports with F9

directly within a spreadsheet application as powerful as Excel.
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3. F9 Report Wizard

Report Wizard is available to step users through defining report dimensions such as: rows, columns, and
the control area, and writes a fully completed F9 report with dropdown controls and F9 formulas for you.

Select or change any of the dropdown controls to calculate new results easily. The initial report can be
expanded upon since F9 formulas are written with the correct cell referencing for all parameters.

Create an Actual versus Budget Report:

1. Select Sheet 2 as the active worksheet and close the Inquire task pane, if open.

From the F9 Ribbon, select Report Wizard: Wawa

Resize the Report Wizard task pane to increase its display by dragging its border on the left towards

the active worksheet.

4. Pick the Macola Demo for Company and hit next.

5. For the Row axis, select Main in the upper window. Next, highlight all accounts that start with 053 and

hit the >> button to move to the selected window.

Select Total and >>. Hit Next.

For the Column axis: select Periods in the upper window. Select Description and >> to move to the

selected window. For Periods, select Month 1 and >> and then 1Budget and >>. Select Variance

and >>. Hit Next.

8. For the remaining axis, select Year 1994, Budget 01 and type in value * for both the Profit Center and
Department. Hit Next.

9. Under Format select F9 Conditional Format and enter a title such as: Actual vs Budget Report.

10. Select checkbox to reverse the sign,

11. Click Finish.

12. Use Auto-fit to resize the columns.

wn

No

A B C D E _|Fla H 1 1 K L
1

2

3 Companie 002 I !

4 Periods Horizontal

5 > Budgets 01

6 Years 1994

7 Main Vertical

8 Profit Cen *

9 Departme *

10

11 Actual vs Budget Report

13 Description Month 1 1 Budget Variance
14 05300 | Interest Expense [ s0.00 [INS0.00 | 0
15 05320  FEreight Other I s0.00 INs0.00 | 0
16 05350 | Insurance 575.00) INS0.00 | -75
17 05360 Advertising [{814,305.00) I¥S0.00 I -14305
18 05380 | Legal & Accounting li81z,320.00) IS0.00 W=12320
19 05390 Miscellaneous Other | s0.00 Ns0.00 | 0
20 Total Total {$26,700.00) [ §0.00

21

The Macola sample company data does not contain budget amounts for the accounts.
Rename the tab to: Report Wizard and save the report.
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4. F9 Sales Report with Filtering

The next example will create a F9 report in the form of a dynamic Excel 2007 table with filtering. Tables in
Excel 2007 offer many new advantages including dynamic formatting, formulas, filtering of one or more
columns to collapse and expand information, as well conditional formatting and KPIs.

F9 Table creates financial table reports for enhanced analysis and business intelligence.

1. From the F9 Table task pane, select the Source tab.

a.
b.

For the Account, type: 03* and other segments: *.
For Period select: January, Budget 01, Year 1994

2. Select the Options tab and change:

a.
b.

C.

d.

F9 Chart: Include Account Code, check Segments in Separate Column
Output: unselect Classic Chart, Paste as GL Formulas

Destination: New Sheet

Formatting: Add Conditional Data Bar, Table style: Light 11 (green)

3. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a
new worksheet.

3 A B [ D E F G
1
2 Companig002
3 Years 19394
4 Budgets 01
S
6 |Accounts: (03%)(*)(*)
7
8
2 :l
10 w7 7 N i N w7
11 03100 00000 00000 Sales-Prod Line A P/L -134,960.00.
12 03100 10000 00000 Sales-Prod Line A West P/L I 0.00:
13 03100 20000 00000 Sales-Prod Line A North P/L I 0.00
14 03100 30000 00000 Sales-Prod Line A South P/L I 0.00:
15 03110 00000 00000 Sales-Prod Line B P/L I 0.00
16 03110 10000 00000 Sales-Prod Line B West P/L I 0.00:
17 03120 0O0OOD 00000 Sales-Prod Line C P/L I 0.00
18 03120 10000 00000 Sales-Prod Line C West P/L I 0.00:
19 03130 00000 00000 Sales-Prod Line D P/L I 0.00
20 03130 10000 00000 Sales-Prod Line D West P/L I 0.00:
21 03140 00000 00000 Service Sales P/L I -s3,400.00
22 03140 10000 00000 Service Sales West P/L I 0.00:
23 03150 00000 00000 Sales Discounts P/L I 4,550.00
24 03150 10000 00000 Sales Discounts West P/L I 0.00
25 03160 00000 00000 sales Returns/allowances P/L I 910.00'

1 4 lec fos. fau PR [

Notice the sales amounts are negative — this can be quickly changed by going to the first cell with an
amount and editing the formula.

1. Goto cell G11.
2. Hitthe F2 key to edit the formula.
3. Change =GL to =NGL and hit Enter.

All formulas below the first in the F9 table are automatically changed. This is one of the advantages of
Tables in that Excel provides extra intelligence to manage its own content.

Filtering:

Notice there are a number of rows with all zeros. Within Tables, one can filter on different criteria over one
or more columns very easily.
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1. Incolumn G, select the down arrow at the cell that displays its heading, Amount January.
2. Uncheck the last item for zero values (0)

-

-

-

&

Sort Largest to Smallest
Sort by Color

Mumber Filters

% Sort Smallest to Largest

] (Select Al
-4,550.00

[ -910.00

[]0.00

[v] 83,400.00
134,960.00

o]

Cancel |

A Quick Tour of F9

Note a filter icon displays to the right of January to indicate a filter is active for this column.

q}. A B C E G

1

2 |Companies 002

3 Years 1954

4 Budgets oL

3

B |Accounts:  [03%)(*)(*]

7

8

9

10 A

11 03100 00000 00000 Sales-Prod Line A P/L I 134,960.00 .
21 03140 00000 00000 Service Sales P/L I 83,400.00
23 03150 00000 0oooo Sales Discounts P/L -4,550.00
25 03160 00000 00000 Sales Returns/Allowances PfL | -910.00
37 Total -212,900.00,
38

Another filter might be to display certain departments or locations. Click on the dropdown for Departments
and select just Department 00000. The report will now display the subset requested.

Rename the tab to Sales Report and save the workbook.

Because the contents of the table report contains F9 formulas, the financial information returned is

dynamic and you can select or change the F9 control area and recalculate for new reports. In addition, it
is possible to expand on the table with new columns for additional periods, for example.

Custom filters can be created to track values or results for a specific business need. Experiment with F9
Table to view different types of results and explore more into the new functionality for Excel 2007 tables.

19



A Quick Tour of F9

5. F9 Pivot Table Report

The next example will create an F9 report in the form of a dynamic Excel 2007 pivot table. Pivot Tables in
Excel 2007 offer many new advantages including dynamic formatting, formulas, filtering of one or more
columns to collapse and expand information, as well conditional formatting and KPIs.

F9 Pivot Table Report creates financial pivot table reports for enhanced analysis and business
intelligence.

1. From the F9 Pivot task pane, select the Source tab — this tab basically describes what data to
populate the Pivot table with.
a. Select the Macola demo company.
b. For Years check both 1994 and 1993.
c. For the Main, type: 05*%, and other segments: *.
d. For Period select: January

F3 Pivot v X
Source ] Options ]
Cornpanies: brd
333
goz |
Budgets: Years:
02 o
03 =] 1992 |
Period:
|Januar\.' j
[~ Usewhole Account
Main:
= -l
Profit Center:
5 [
Department:
¥ [

2. Select the Options tab — this is used to provide more detail on how the Pivot table content will be
managed:

a. Check Segments in Separate Columns
b. Inthe Create supporting amounts as: dropdown select NGL Formulas
c. Check: AutoFit Pivot Table Columns

20



'iFg P

Source Options

v SegmentsinSeparate Columns
[~ Include Description

[™ Incude Account Ori

[~ Prependthe Account Code a’
[ Skip Accounts Showing all Zeros

Create supporting amounts as:

MaGL Formulas j

Destination:
f+ MewSheet

("~ CursorPosition

[ AutoFitPivotTable Columns

[~ Recalc/Refresh in Manual

A Quick Tour of F9

Click on the Create Pivot Table button at the bottom of the F9 Pivot task pane to have an initial
Pivot Table report generated.

To calculate values, click anywhere inside the Pivot report and then right-mouse click and select
Refresh.

After AutoFitting the columns, the results should look similar to:

B
1 Department  (all) (] |
2 ProfitCenter  (all) [~]
3
4 sum of Amount YearsEPeriod E
5 -11993 1993 Total  =1994 1994 Total
6 Main January January
7 05010 0.00l 0.00 0.00 0.00}
8 05012 0.00 0.00 0.00 0.00]
9 |05015 0.00 0.00 0.00 0.00}
10 05017 0.00 0.00 0.00 0.00]
11 05018 0.00 0.00 0.00 0.00]
12 05019 0.00 0.00 0.00 0.00}
13 05020 0.00 0.00 0.00 0.00]
14 05025 0.00 0.00 0.00 0.00]
15 05040 0.00 0.00 0.00 0.00]
16 05130 0.00 0.00 0.00 0.00]
17 05140 0.00 0.00 0.00 0.00}
18 05150 0.00 0.00 0.00 0.00]
19 05160 0.00 0.00 0.00 0.00]
20 05210 0.00 0.00 -8500.00 -8,500.00)
21 05230 0.00 0.00 0.00 0.00]
22 05235 0.00 0.00 0.00 0.00]
23 05240 0.00 0.00 0.00 0.00]
2405250 0.00 0.00 0.00 0.00]
25 05251 0.00 0.00 0.00 0.00}
26 05252 0.00 0.00 0.00 0.00]
27 05253 0.00 0.00 0.00 0.00]
28 05254 0.00 0.00 0.00 0.00}
29 05255 0.00 0.00 0.00 0.00]
30 05256 0.00 0.00 0.00 0.00}
31 05257 0.00 0.00 0.00 0.00]
32 05258 0.00 0.00 0.00 0.00]
33 05280 0.00 0.00 0.00 0.00}
34 05300 0.00 0.00 0.00 0.00]
35 05320 0.00 0.00 0.00 0.00]
W 4 s Wl Tralosheea 1 TralOskeca 3 Chaats o Chastd 1 Dacr NG

A

imrnmt

Source Options.

¥ Segments inSeparate Columns
I~ Include Descripion

I~ Include Account Drigin

[~ Prependthe Arcount Codea
I~ skipAccounts Shawing all Zeros

Create supporting amourts as

NGL Formulas -

Destination
(+ MewSheet
( CursarPosition

[¥ AutoFitPivatTable Calumns

I” Recal¢/Refresh in Manual

Create Fivot Table

PivotTable Field List v x

Choose fields to add to report:

[ Companies
[Budgets

& Years

[ Main

[l Profit Center
[¥] Department
@ Period

[¥] Amount

Drag fields between areas below:
¥ Report Filter 7 Column Labels

Department  ~ | | Years -
ProfitCenter ¥ | | Perind >
i RowLabels T Values
Mzin ~ | | sumof Amount ~

[] Defer Layout Update:
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Note amounts are shown broken down by Year. To showcase some of the capabilities of the pivot

table, move filters to different areas using the provided PivotTable Field List task pane. For
example, drag Years to Report Filter, Department to Row Labels and Profit Center to the Column
Labels area:

Drag fields between areas below:
W Report Filter

Years h
14 Row Labels
Main h

Department -

4 Column Labels

Period b
Profit Center

E  Values

Sum of Amount ¥

Defer Layout Update

7. The report will display as:

15
16
17
18
19
20
21
22
23
24
25
26

Years

(all) -

Sum of Amount

= 05010

05010 Total

Period |~ Profit C(~
~January
100000 10000 20000 30000

January Total

Main vIDEEartment )

00000
01001
02001
03001
05002
05003
06001
06002

0.00
0.00
0.00
0.00
0.00

05012
05012 Total

00000

=05015
05015 Total

00000

05017
05017 Total

00000

=05018
05018 Total

00000

=I05019
05019 Total

00000

8. Select different Years and refresh the table for results to change. Note that you also have filters
available to you on both the rows and columns to display totals, for example, for certain
departments or locations.

9. Another feature with Pivot tables is drill. Select a cell with an amount and either double-click or
right-mouse and select Show Details. The details that total this amount are shown in a newly
created tab.
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3 [002 01 1994 05210 00000 00000 January -8500

Experiment with F9 Pivot Table to view different types of results and explore more into the new
functionality for Excel 2007 pivot tables.

Congratulations - this completes the F9 Quick Tour!
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Appendix A: F9 Parameters and Syntax

1. Period Specifiers

In F9, the Period specifier is used to identify the period or periods for which you are requesting account
balances and uses logical, plain-English terms.

Period Specifier

Examples Description

Month 1 The first period of the fiscal year
This Month, Month  |The current (usually open) period

This Month Last

Year The current period in the previous year

Last Month The period before the current period

Total for the year including the current period (applies only to P/L accounts as BS

Year to Date, YTD accounts are returned as a cumulative balance by default)

Period 2 activity (applies only to BS as P/L accounts are returned as transactional

Change Month 2 values by default)

September The balance for September
Quarter 1, QTR 1 Total for the first quarter

You may notice that your Balance Sheet accounts have the same value for a consecutive number of
periods (current period and all future periods). F9, following the principles of accounting, returns Balance
Sheet accounts as a cumulative balance. P/L accounts are returned as a monthly change value.

2. Account Ranges

In most financial reports you will want to return values for a range or series of accounts in one cell.

For example, to return a value for all of your cash accounts (a Natural Account code of 1000 through
1090), you would specify a range of accounts that includes all cash accounts. Let's assume that you have
a three-segment account code where the first segment of your account code is the Department, the
second is the Natural Account and the third is the Sub-Account. In this example, the Account specifier
would be *-1000..1090-*. This would return the value for all accounts between 1000 and 1090 for all
Departments and all Sub-Accounts. As you can see Wildcards (the asterisk) can be used in specifying
ranges of accounts with F9.

Account

Specifier Description Example Result

.k k Returns all accounts, all departments, all profit
centers.

Matches any character, or
* set of characters 4000-*-100
regardless of length.

Returns the 4000 accounts for all departments
in the 100 profit centers.

Returns all accounts that start with a 4 for

*_ -
4*-010-100 Department 101 and profit centers 100.
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Returns all accounts that have a first

” Matches a single character 4200-010-100 character of 4 and third and fourth character
' in the exact position. ' of 0 for Department 010 and profit centers
100.

Returns all accounts from 4000 up to and
4000..5000-*-* |including 5000 for all departments and all
profit centers.

Indicates a range of
account segment values

Creates a list of account 4000-010- Returns a balance for the sum of account
, specifiers or account 4000-010-100 and 5000 with all departments

_k_*
segments. 100,5000 and all profit centers.

**Please note that for most ranges of accounts to work, you must have Return Zero For Account Match
Not Found selected in F9 Setup.

Although these Account specifiers may seem to be able to accommodate every aspect of your reporting
needs, imagine if you wanted to create a departmentalized report for each department. Using the above
Account ranges will accomplish this, but you will have to recreate the report for each department,
reentering the appropriate account ranges, each time specifying a different department.

A very important feature of F9 is allowing you to cell reference each segment of your account code
individually, so that you can make your report turn on any segment of your account code. This is
accomplished with the BSPEC Function.

3. BSPEC

The BSPEC function expands the functionality of the Account specifier by Building the Account
SPECiIfiers from cell references. The BSPEC is really just the Account parameter in any F9 formula that
uses an Account parameter. The Syntax of the BSPEC is:

=BSPEC(Segment 1, Segment 2, Segment 3)

Where:
Segment 1 is a cell reference to the first segment of your account
Segment 2 is a cell reference to the second segment of your account
Segment 3 is a cell reference to the third segment of your account

There can be as many Segments as your account contains.

The GL formula with the BSPEC function will look as follows:
=GL(BSPEC(Segment 1, Segment 2, Segment 3), Period, Company, Year, Type)

In any F9 formula that references an account number, the BSPEC can also be a cell reference. The
easiest way to learn the BSPEC function is to see it in use. Refer to the steps under GL Paste within this
Quick Tour as a good example.
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